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1 INTRODUCTION

Figure 1-1 The Airy beam illumination profile that defines the Aurora™ Light Sheet system

1.1 Airy beam light sheet

The M Squared Aurora™ microscope is an Airy beam light sheet microscope. Instead
of using the Gaussian beam illumination profile that is common to most light sheet
microscopes, it uses an Airy beam illumination profile (Figure 1-1). The optical
properties of the Airy beam in the Aurora™ microscope result in the following
advantages in comparison with other light sheet microscopes:

e Image contrast maintained throughout the entire field of view of the camera,
instead of having good contrast only at the centre of the field of view.

e Improved axial resolution over the same field of view.

e A “self-healing” light sheet that reduces striped shadow artefacts commonly
encountered in other light sheet modalities”.

The trade-off is that the Airy beam shape needs to be deconvolved. Deconvolution is
explained in the following section.

1.2 Deconvolution and the Point Spread Function (PSF)

In microscopy, light emitted from a point source smaller than the resolution of the
optical microscope will produce an image described as the Point Spread Function,
or PSF. The PSF is formed as a convolution of the instrument’s optical response and
the sub-resolution point source. The same PSF applies to all images acquired using
the microscope optical system. By recording and measuring the PSF using an
appropriate sub-resolution point source, e.g. fluorescent beads, software can be used
to deconvolve images to remove the effect of the optical system and recover the
underlying biological structures.

In the case of the Airy beam, the lobe structure of the beam distributes the excitation
light throughout the sample which results in several benefits:

e The lobe structure encodes high resolution information that is restored by
deconvolution, resulting in better axial resolution over the same field of view
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as a Gaussian-beam light sheet system or a confocal microscope with the
same NA detection objective lens.

e The deconvolution process boosts the image signal and minimizes the
background noise, improving image contrast.

e The combination of the above two points allows lower peak laser powers to
be delivered to the sample for the same output image signal. Thus, the spread
of the laser intensity throughout the sample effectively minimizes
photobleaching.

This user guide will show you how to obtain the PSF of your microscope, mount and
image your sample, and how to deconvolve your acquired data.

1.3 Aurora system layout
1.3.1 Aurora system setup

The Aurora™ system is configured as an upright light sheet microscope. The system
uses two objective lenses at 90° to each other to image the sample: one illuminates
the sample using an excitation laser beam, the other detects the fluorescence
emission and sends it to the camera.

1.3.2 Objective lenses and stage geometry

Located beneath the objective pair is a stage top with a number of translation axes,
the most common is a 4-axis configuration with X, Y, Z, and XZ directions. Some
systems may have a slight variation on this, but the purpose is the same: to position
the specimen at the focal point of the system and to perform the 3D volumetric scan.
There are two scan methods used for creating a 3D stack:

1. stage scan, where the specimen is moved by the dedicated XZ-scan
translation stage through the static position of the light sheet and system focal
point;

2. beam scan, where the light sheet and system focal point are re-focused and
moved through the static position of the specimen.

More details on how to use these two methods are described later in the Acquisition
chapter.

The 3D scan axis is defined by tracing the perspective of the detection lens down
towards the stage top and typically sits at 45 degrees to the horizontal. This axis
defines the optical z-axis of the detection objective lens. We name this the “XZ”-axis
SO as not to cause confusion with the vertical Z-axis of the X-Y-Z

Note that the maximum upwards extension of both the Z and XZ axis stages should
never touch the housing of the objective lenses; the sample chambers are also
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accounted for in this limit. Protective limits to the stage travel are set by the M Squared
Life engineer during installation.

15x illumination Obj.

15x Detection Obj.

Vorking Distance: \ Working Distance;

XZ-axis
of scan
stage

45-degree
translation

Z-axis of Lower Limit

¥ertical X-Y-Z STAGE
stage

Figure 1-2 - Geometry of objective lenses and stages



Version 1.2 — Acquisition Manual: Aurora Airy Beam Light Sheet Imaging System

Acquisition version: 0.5.0

2 OPERATIONAL INSTRUCTIONS

2.1 Computer start-up

Begin by logging into the computer supplied with the Aurora™ system. This computer
is preloaded with Microsoft Windows Operating System and all the relevant software
needed to obtain and process microscope image data.

2.1.1 PC log-in details

The PC will be set up to have a single Aurora User account. The password for the user
is: M2Life (M and L are capitalised).

2.1.2 PC start-up — normal operation

In normal operation the computer will have been left on since the previous imaging
session. Log into the Aurora User account to access the Desktop.

2.1.3 PC start-up — after long term shut down

After a long-term full shut down, the PC will require powering-up before continuing with
the start-up procedure for normal operation

2.1.4 System start-up — after power cycle

After a power cycle additional care must be taken in powering up the Aurora system.
The Prior ProScanlll will need to be turned on first before the PC and all other
microscope components. You must not attempt to use the microscope before the
calibration of the Prior ProScanlll has been checked.

IMPORTANT: IF IT IS CLEAR THAT A POWER CYCLE HAS OCCURRED, THEN CONTACT THE
M SQUARED LIFE TEAM WHO WILL ASSIST YOU IN PROCEEDING.

2.2 Start-up procedure
After following the relevant PC start-up instructions above, continue with the following
instructions.

2.2.1 Turn on camera water-cooler and camera

In most recent Aurora™ systems access to the power switch on the back of the
camera is not possible. In such systems both the water cooling and the camera power
switch are always in an “on” position, and overall power to both is controlled by a mains
plug outside the microscope enclosure. In older systems where the camera power
switch is accessible both will need to be turned on separately; the water cooling first,
followed by the camera.

The power switch on the camera water-cooler is on a small controller box mounted to
the cooler side, turn that on and leave for 30 seconds. Next, flip the Hamamatsu Orca
Flash 4.0 power switch to the “on” position, which is located on the back of the camera
by the power cable. This will start the Peltier cooler inside the camera, which will be
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silent due to water cooling mode being enabled. Wait for the blinking green light on
the back of the camera to turn solid orange.

IMPORTANT: DO NOT YET ATTEMPT TO OPEN THE ACQUISITION SOFTWARE.
2.2.2 Turn on laser box

Press the laser box power button on the front into its recessed position until it clicks
and stays put. The safety/standby key will also need to be switched from the off
position to the on position for any laser light to be emitted. Wait for any blinking lights
to turn solid.

2.2.3 Open acquisition software

Once the PC and all microscope hardware is turned on, the user can open the
acquisition software and begin imaging, as detailed later in the Acquisition chapter.

2.3 Shut down procedure
2.3.1 Shut down - daily use

Following an imaging session, the microscope peripherals are turned off, but the PC
should be left on. Close down the acquisition or deconvolution software and log out
from the Aurora User account. Once the acquisition software is closed, turn off the
power-strip for all microscope peripherals that do not require power on all the time.

Please do not shut down the PC or turn off the screen as this prevents the M Squared
Life team from remotely accessing the machine for software troubleshooting or
maintenance.

WARNING: ENSURE THAT THE POWER FOR THE PRIOR PROScCANIIl STAGE AND
FILTER WHEEL CONTROL BOX REMAINS POWERED-ON AT ALL TIMES.

2.3.2 System shut down — long term

For longer term shutdown, such as during holiday periods, the PC may be shut down
completely, if desired. Please note that this means the M Squared Life team will not
be able to connect remotely during this time. Again, it is important that the Prior
ProScanlll is not turned off during this time otherwise it will require recalibration, if this
happens contact the M Squared Life team.

10
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3 ACQUISITION

This user guide covers the M Squared Cubes user interface for the Aurora™
microscope, containing sections describing system operation and image
acquisition.

3.1 Software Version
This guide refers to software version 0.5.0.

3.2 Basic software features and operation

An outline of what the basic functions are to operate the system acquisition software
are outlined in this section. Later sections will discuss sample loading and give details
on how to use the acquisition software to acquire basic image z-stacks.

&4 M Squared Aurora Acquisition plugin 0.5.0 - O
Exp. (ms) Binning Current Reference: Camera reference mode
Live 10 Lo Start Acquisition
Snap single image Crop Image SQUARED
GFP vl Constant Velocity Acq. ~
ass | 5 %
Immersion Medium
Wherw | & , Edit Current Overview Acquisitions: Xz z
No Images Open * *
Copbeste Move stage to point.
Preset stage positions [T Time-tapse [7] Multi-Positions ’ t ’ l
el Chiannels V] z-Stack A A

XY.X
Load Position
&« €« (¢
Relative positions

XZ Stage: 500 ym

Focus Stage: XZ S Z Stage: -100 ym
XY.X Stage: 600 pm
Wobble delay (secs ) 0 XY.Y Stage: 499.995 pm

KL e ) P MPE
v
¥
¥

(&
«
«

Stack start | -100

Go to middle

Stack end 100

+ = Edit Move to
Define size of steps 04 pm

Configure User Settings

File folder D:\TestData\New Sample

File name | organold [+/] Split in folders? [/] Save file?

Number of slices: 500
Spake el Waiting for channel GFP to switch.
Stack size: 200 ym g
FOV: 870.35x870.35 pm

Number of channels: 1

Number of time points: 1

Number of positions: 1

Time per acquisition: 00:00:0¢

Total time-lapse: 00:00:05

Stack file size: 4.1 GB

Acquisition size: 4.1 GB

Figure 3-1 The M Squared Cubes Acquisition GUI
3.2.1 Start-up

e Turn on all hardware before starting the software.

e Double click the shortcut icon on the desktop linked to the acquisition software.
The icon will be called ‘Aurora Acquisition’ or similar, though this can be
modified by the user. On older systems this may be called ‘Micro-Manager’.

11
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e The software will ask for a configuration file: just press OK. The software will
then automatically connect all equipment to Micro-Manager and open the M
Squared interface for image acquisition (Figure 3-1).

e If there are any problems during loading of the Micro-Manager software, the
most likely cause is that one of the pieces of equipment is not turned on or
has not had time to fully start up. In that case, close the software and restart
the equipment listed in the error. If the problem persists, contact one of the M
Squared support team.

Once open, three windows will be displayed: The Aurora™ Acquisition plugin (Figure
3-1), a Micro-Manager window, and an ImageJ control bar:

e The Aurora™ Acquisition plugin (AAP) allows direct control of all features of
the Aurora™ Airy light sheet microscope.

e The Micro-Manager window (MMW) allows for histogram and look-up table
adjustment.

e The ImageJ control bar is used to display and analyse images that are
recorded using the microscope camera.

12
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3.2.2 Warning: Configuration Window

Configure MSquared Acquisition X
Channel Group
Lhannels 7

[] Trigger camera?

Camera triggering device:

DHub v
Stage Label Axis Max. VelodtyMin. Pos. Max, Pos. Invert

z z w1 -10,000 10,000 O

Xz Xz v|1 -10,000  |10,000 |

XY X 1 -10,000  |10,000 O

XY Y 1 -10,000  |10,000 O

Maximum buffer size (GB) | 16

Detection Objective
Navitar v

Detection Objective magnification 15.287
Detection tube length 200

Detection Numerical Aperture 0.367
Tlumination Objective

Navitar v

Tlumination Objective magnification’ 15.287
Shutter that controls the galvo

GalvoShutter v
Galvo Shutter Delay (ms) | 200

Confirm Cancel

Figure 3-2 Configuration window

If there is any change to the microscope hardware, a configuration window will appear
asking you to manually input several settings, this window is shown in Figure 3-2. It is very
important that the settings entered here exactly match your Aurora™ system setup, and so
if you see this window immediately when opening the software, please contact the M
Squared Life team and press the “Cancel” button. The window can also be accessed directly
from the acquisition software, so if you accidentally bring open this window in error, simply
close it to return to the GUI by pressing the cancel button.

3.2.3 Microscope Controls

The following section will walk you through the controls featured in the microscope
software which are necessary for positioning and live imaging the sample, which are
pre-requisites for loading a sample onto the system before beginning an imaging
session.

3.2.3.1 Sample positioning (AAP)

Sample positioning is achieved using the button map on the right of the GUI plugin
(Figure 3-3). The translation stages implemented in the system are controlled using
the three-increment positioning buttons, one for each translation stage. A small (>),
medium (>>), and large (>>>).

13
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b
<

.Y Current Overview Acquisitions: Xz
No Images Open ~

Move stage to point

> 2D
> D D~

XY.X

« € <

XZ Stage: 500 pm

Z Stage: -100 pm

XY.X Stage: 600 pm
XY.Y Stage: 499.995 um

> > P

KLCED DD

¥ ¥
¥ ¥

Figure 3-3 Example positioning controls for a 4-axis stage configuration

The stage control area also shows the current stage positions under the left-hand side
arrows.

Increment amount can be set using the "User Settings" button in the lower left of the

plugin window (Figure 3-1). The stop button can be used to stop all stage movement
in an emergency.

User Settings

Stage User Reference  Camera Reference> (um)
FIX5Stage Fositive Positive
PIYStage Positive Positive
FIZ5tage Fositive Positive
PIXZ5tage Positive Pasitive

Confirm Cancel

Figure 3-4 Set positioning increments using the "User Settings" button

Above the positioning controls is a button that switches between "User Reference Mode"
and "Camera Reference Mode". "User" mode moves the stages as a user would expect
when looking directly the stages. "Camera" reference mode moves the stages as
expected when looking at the live image displayed on screen from the camera. In this

14
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case, the software accounts for the 45-degree angle of the objectives, making the
sample move as you would expect.

3.2.3.2 Live view controls (AAP)

i Exp. (ms) Binning
Live 10.007
| Snap single image | | Crop Image |
|SingIE-RFP o |
561 Laser | 1 |

Figure 3-5 Live view and channel selection

At the top left of the GUI plugin window (Figure 3-5) is a channel selection drop-down
menu in which the user can switch between channels for live viewing. A channel will
automatically select a pre-defined fluorophore which is denoted by a laser wavelength
and filter combination. Once selected, the user can then specify the desired exposure
time (ms) and laser power (%) for the live view. The user can select "Live" mode to live
stream a view of the sample; this will mean the laser is on for as long as “Live” is
selected.

The other option, "Snap single image”, will only capture a single frame image with the
preset exposure rate. Either option will open the live window (Figure 3-6). The live
view may be preferable when positioning the sample, whereas the snap image may
be preferable when wanting to avoid photo damage to delicate samples whilst trying
to adjust your imaging settings.

d Snap/Live Window (not yet saved) (100%) = o X
. 76x143 71 2) it 512

x=502. y=258. value=530 PosD, 18.20s. 2 0 um, Default

® = Glswe @ ive =5 Album

Figure 3-6 Live image window

15
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The third feature “Crop Image” allows the user to reduce the field of view to a custom
region.

It is recommended to begin imaging using low laser powers (1-10%) and modest
exposure times (50ms-100ms). Once an area of interest is found exposure times and
laser power can be adjusted to improve signal. An imaging walkthrough is given in
detail later in chapter 7.1.

3.2.3.3 Preset user position list (AAP)

Predefined positions can be stored and easily accessed using the "Preset stage
positions" box on the left of the GUI (Figure 3-7). The system will be setup up with
some preset positions, like sample loading position.

Preset stage positions

Name

Image: Bead Top
Image: Bead Middle
Position_3
Position_4
Position_2

& = Edit Move to
Figure 3-7 Position presets

e To store the current stage position, select "+".

e Click "-" to remove a position that is no longer needed.
e Select "Edit" to alter the coordinates or alter the name.
e The name can also be altered by double-clicking.

¢ Move to a position by selecting the position on the list and clicking the "Move
to" button.

The “Move To” function performs a safe move. If the Z or XZ stage is part of a
combination of moves that require the stage to move up, the X and Y axes are moved
first then the Z/XZ axes. If the combination of moves requires the stages to move
down, the reverse occurs: The Z/XZ stages move down first, and then the X and Y
axes will move. The reason for this is to avoid any potential collisions of the sample
chamber with the objectives.

16
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3.2.3.4 First time use: storing loading positions

Storing custom positions in the GUI allows quick repeatable positioning. To pre-set
those positions first ensure the “User Reference Mode” is selected in the acquisition
GUI. To establish the “Sample Loading” position:

1. Lower the XZ and then the Z stages so that the stages are at the lowest
position.

2. Store this position as the “Sample Loading” position by click the ‘+’.

To establish the “Centre Sample” position:

1. Gradually raise the stage-top, alternating between the Z and XZ axis to ensure
that the centre of the sample chamber is in line with the observation axis of
the detection objective.

2. Adjust X and Y where appropriate to make sure that the objectives do not
touch the edges of the sample chamber as XZ and Z are raised.

3. Store the raised position as the “Centre Sample” position in the user position
list.

Now you can move easily between the two loading positions when swapping out
samples.

3.2.3.5 Adjust the image contrast (MMW)

Once live view is started, or an image is snapped, the Micro-Manager window will
display the histogram for that image (Figure 3-8). The contrast of the image displayed
is usually automatically stretched to adjust to the signal range that the camera
captured. This can be turned off by unchecking the “Autostretch” checkbox, but it is
recommended to leave this option on. Additionally, the “Autostretch” mode can ignore

Autostretch ignore % 0.01-% []Log hist

| v
Full Auto
Hist range A 3
Camera Depth v
Min: 4,792
Max: 5,420
Mean: 5,098
|Std Dev: 70

4838 65535

Figure 3-8 Histogram for the "Live" window

17
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the brightest pixels (as these tend to be just noise) when performing the contrast
adjustment. We suggest using 0.01% for the “Ignore %” function and checking the box.

3.2.3.6 Optimize the signal (MMW & AAP)

Use the histogram for signal optimization to indicate how strong or weak the signal is.
For efficient acquisition, we recommend taking “snaps” of the sample and gradually
adjusting the laser power and exposure until the maximum signal value is between
1/4-1/2 of the total available signal range, i.e. (15,000-32,000). Additional information,
guidelines, and examples regarding signal optimization can be found in chapter 7.1.

Important: When using the “Ignore %” function, the vertical lines on the histogram will
not show the real signal maximum. Instead remember to use the “Max:” value
displayed to the left of the histogram window.

3.3 Sample Loading

Select the “Sample Loading” position in the position list at the left of the GUI to safely
lower the stages from the imaging without risk of contact between the objective lenses
and the sample chamber. If the “Sample Loading” position is not listed in the user
position list, then please follow section 3.2.3.4.

Place the prepared sample chamber (containing sample and immersion media) on to
the stage-top, taking care not to touch the objective lenses with the sides of the sample
chamber. Select the preset “Centre Sample” position, in the position list, to safely raise
the stage from the lowest position to the appropriate safe starting point for sample
imaging. At this point the lens of the objective should be in contact with the immersion
media. You are now ready to move the sample into the field of view.

Warning: Be patient with stage commands in Micro-Manager, otherwise Micro-
Manager may crash. After the stage begins to move do not click to start any other
processes and avoid clicking the navigation buttons multiple times.

3.3.1 Coarse adjustment — live view brightfield channel

Perform sample positioning using a “Live” view of the brightfield channel so that the
sample position in relation to the imaging optics can be judged both by eye and using
the detection camera image. Select the “Brightfield” channel from the dropdown menu
this will initiate live imaging window to appear and a white LED to activate for gentle
sample illumination.

Starting from the safe “Centre Sample” position, you may now adjust the X, Y, Z
translation stage to move the sample to a position that is inside the field of view of the
detection objective. Navigate the stage to move the sample towards the focal point,
into the beam of white light now visible by eye in the sample chamber solution.
Continue adjustment until the live view window on screen displays some sample
structure.

18
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Tip: Tick the “Autostretch” box, with “Ignore %” set to 0.01 to adjust the image display
to ignore very bright regions and see more of the sample.

3.3.2 Fine adjustment - live view laser channel

Once the sample appears in place using the brightfield the channel can be switched
to the required laser channel using the drop down. Select a low power (<3%) with a
short exposure time (< 50ms), selecting the live button will open a new live window.
Now it is possible to check that features of interest are visible in the live window.
Finally, use the stage to navigate using small steps until the appropriate region of
interest in the sample has been located.

WARNING: REMEMBER TO TURN OFF LIVE MODE WHEN NOT LOOKING AT THE SAMPLE TO
REDUCE PHOTO-TOXICITY OR PHOTO- BLEACHING EFFECTS.

3.3.3 Record starting position and begin setting imaging parameters

Once the appropriate region of interest in the sample has been located, positions can
be stored in the preset position list for easy navigation while search the sample. It is
useful to keep track of the various starting positions used during the imaging session
as the stages can quickly return to these positions if required.

3.4 Acquiring a z-stack

After finding the sample and adjusting channel and laser power, the user can start
acquiring images of the sample. There are a range of acquisition methods that can be
set using the Acquisition Settings panel (Figure 3-9).

M Start Acquisition

SQUARED

Constant Velocity Acqg. ~

Immersion Medium

Water ~ + = Edit
Calibrate RI
[ ] Time-Lapse [ ] Multi-Positions
Channels Z-Stack

Figure 3-9 The Acquisition settings panel

Prior to the start of any imaging it is important to set the refractive index of the sample.
Incorrect Refractive Index will cause multi-positions will not work properly and the pixel
size information for the images will be wrong.
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Important: Ensure the correct immersion medium has been selected before acquiring

any data.

3.4.1 Step 1: Choose refractive index

Select the correct sample immersion medium from the dropdown list under “Immersion

Medium”. If the medium is not listed, it can be added by pressing

“w,n,

+

7

press “-” to

remove a medium; and “Edit” to adjust any of those mediums already listed.

Alternatively, if the refractive index is not now, the stage can attempt to calibrate for it.
For that function, press “Calibrate RI”.

5.1.1 Calibrating refractive index

There are situations where the RI can be uncertain. For example:

* You do not know any more the mounting medium or clearing solution used with

the sample

* A significant amount of time has passed since the sample was made and
evaporation may have changed the RI

* The sample Rl is known but the immersion medium has a different RI.

In such cases, we provide a method to estimate the sample RI, by performing
calibrated motions. To do so, press the “Calibrate RI” button (Figure 5.1). The below

window should appear.

&# Calibrate RI X

This calibration routine will move the stages by a certain amount,

take a few snaps and use this information to calibrate the
apparent refractive index. Please make sure you have a sample,
that you're focused near its surface, that it's in the centre

of the field of view and that it won't bleach much.

For dual camera systems, please use a single camera channel.

If your sample is wobbly, we advise against calibrating.
But you may try using the below text box to introduce a wait
(in seconds) between any stage move.

0
You may set below the name of the medium.
[] Edit Name?
Press start when ready.

Start Cancel

Figure 3-10 RI calibration window

After the calibration procedure is finished, a refractive index option will appear in the
refractive index list, appended with the current date and time or named according to

the “Edit Name?” option in the above calibration window interface.

3.4.2 Step 2: Choose dimension settings

The acquisition dimensions of Channels, Z-stack, Time and Multi-Position are set by
selecting the check boxes in the tabs of the acquisition settings panel (Figure 3-9).
The Channels must always be defined in order to acquire any data; the other
dimensions are optional. To only select one dimension, deselect the other check
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boxes. For a simple first acquisition we recommend recording a z-stack of your sample
with one channel, checking the Z-Stack check box, and de-selecting the Time-Lapse
and Multi-Positions check boxes.

3.4.2.1 Z-Stack settings

[] Time-Lapse [] Multi-Positions

Channels Z-Stack

Relative positions

Focus Stage: | XZ ~

Wobble delay (secs ) 0
Stack start |-100 Set Go
Go to middle Go

Stack end 100 Set Go

Define size of steps 0.4 pm

Figure 3-11 Z-Stack settings

In the Z-Stack settings panel, users can choose the settings for the z-stack (Figure
3-11). There are options regarding the stack depth, slice spacing, and acquisition type.
First, the positions can be set in absolute positions or relative positions.

e Absolute positions: The focus stage will visit the exact coordinates typed in
the “Stack start” and “Stack end” boxes, using the stage coordinate system.

e Relative positions: The stage start and stop coordinates are entered as if the
current position is the 0 coordinate. If a user types “-100” as the stack start
and “100” as the stack end, the stage will move 100 down from the current
position, and then scan 200 up from that point until reaching a position that is
100 above the current position.

The focus stage can be selected as well. The options will depend on your system
configuration but can include “XZ Stage” (alternatively, “Focus Stage”), “Beam
Scanner”, and X-Stage.

WARNING: THE X-STAGE FEATURE IS A WORK IN PROGRESS AND DATA CAN NOT BE
DECONVOLVED AS OF DECONVOLUTION VERSION 0.5.0.

For samples that are motion sensitive and might “wobble” whenever the stage moves
a delay (in seconds) can be added before each stack starts.

In absolute position mode, the “Stack start” and “Stack end” boxes have two buttons
associated:
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e “Set”. takes the current stage coordinate and sets the position in the
associated box.

e “Go”: will go to the position set in the associated box. The middle “Go” button
will visit the middle point of the stack (disabled in relative position mode and
with beam scanning systems).

Users can specify the number of slices or the size of the steps of the stack. To toggle
between these two options, simply click the option toggle button “Define number of
steps / Define size of steps”.

We recommend that a step size of 0.4um is used for most systems to allow high
resolution images to be obtained. Step sizes larger than this will not deconvolve as
well and will result in low resolution images.

3.4.2.2 Stage scanning or beam scanning acquisitions

There is an additional checkbox on the Z-stack settings panel which provides the user
the option of two acquisition types:

e Stage Scanning: where the sample is moved through the light-sheet.

e Beam Scanning: where the light sheet moves through the sample, and the
sample remains completely static.

Beam scanning mode is recommended for delicate samples, or for very rapid

acquisitions with short exposures. Stage scanning mode allows deeper stacks to be

acquired than beam scanning mode. Note that in beam scanning mode, only relative

positions can be used and the “Set” and “Go” buttons are disabled.

3.4.2.3 Channel settings

In the Channel settings tab (Figure 3-12) select which channels to acquire, and the
] Time-Lapse [ Multi-Positions

Channels I-Stack

Channels to acquire

Channel Exp L.1 Pw (%),
[] |align 10.0 |561Laser |2.0 ~
[ ] DAPI-GFP-RFP-CY5 [10.0 [561Laser |2.0
[ ] Dual-DAFI-CYS 10.0 405 Laser |2.0
[] |bual-DAPI-RFP 10.0 405 Laser |2.0
[ ] |Dual-GFP-CY5 10.0 [488 Laser |2.0
[ ] |Dual-GFP-RFP 10,0 [488 Laser |2.0
[] |Single-CY5 10.0 (547 Laser |2.0
[ ] |single-DAPT 10.0 405 Laser |2.0 "
<« s

Figure 3-12 Channel settings

exposure time and power level for each channel during acquisition. For systems with
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dual-cameras and/or split-views, the list will allow for more than one power setting per
channel to be set. Scroll the table horizontally to see the values for all lasers
associated with any given channel.

3.4.3 Step 3: Choose acquisition type - Constant velocity acquisition

Start Acguisition

Constant Velocity Acg. -~

Constant Velocity Acqg.
Overview

Wiat Start/stop Acqg.
|Static Beam

Figure 3-13 The Acquisition mode drop-
down menu

Below the big red button to start an acquisition is a dropdown menu allowing selection
of the acquisition mode (Figure 3-13). Constant Velocity acquisition allows for very fast
stack acquisitions and is recommended for most users. The operation of the remaining
modes is discussed later in this chapter. For very large step sizes the exposure
duration may become extended during acquisition to accommodate the limited speed
of the translation stage/mirrors.

3.4.4 Step 4: Set save location for data

File folder D:\TestData\New Sample

File name |organoid Split in folders? [v] Save file?

Figure 3-14 Save folder and filename settings

Before clicking "Start Acquisition" ensure that a file folder and file nhame have been
specified in which to store the acquired data, and that the "Save file?" check box is
selected (Figure 3-14). Since the software automatically date-and-time-stamps
acquisitions, it is not necessary to manually change the file name between
acquisitions, as subsequent acquisitions do not overwrite previous ones.

The software automatically creates a nested folder structure for each acquisition. This
can be turned off by toggling the “Split in folders?” option.

3.4.4.1 A note on data storage

For fast acquisitions (exposure < 50ms), data should be saved to the fastest storage
available. For older systems where a temporary buffer SSD (Solid State Drive) was
provided, the data should initially be saved on the temporary buffer to allow the fast
transfer of data from the camera to the computer. In this case, move the acquired data
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to the archive buffer at the end of each imaging session to maintain enough space to
acquire more data in future sessions, otherwise data may not be recorded properly.

In newer systems where an SSD buffer drive was not provided, there is a large-storage
hard drive array (RAID) which is fast enough for directly saving acquisition data.

3.4.5 Step 5: Check acquisition information

Number of slices: 1

Step size: 200 pm

Stack size: 200 pm

FOV: 149,76x149.76 um
Number of channels: 1
Number of time points: 1
Number of positions: 1
Time per acquisition: 00:00:00
Total time-apse: 00:00:00
Stack file size: 0.5 MB
Acquisition size: 0 GB

Figure 3-15 Acquisition storage details and
estimates

The lower left of the GUI displays a number of useful duration and storage estimates
related to the selected acquisition settings that allow the user to double-check the
capabilities of the system, ensuring that there is adequate storage space for the
acquired data set (Figure 3-15).

IMPORTANT: DUE TO THE LARGE VOLUMES OF DATA THAT CAN BE GENERATED, IT IS
IMPERATIVE THAT A CAREFUL EYE IS KEPT ON THE AVAILABLE STORAGE LEFT ON THE ALL
THE DRIVES AND REMOVED ONCE THE STORAGE STARTS TO FILL UP TO A MORE
PERMANENT LOCATION.

3.4.6 Step 6: Acquire and check data

Once all previous steps have been followed, the system is ready to acquire data. Click
the large “Start Acquisition” button above the acquisition type drop-down menu to begin
capturing data. When an image stack has been captured, examine the signal level in
the data using the histogram to see if the laser power or exposure need altering, as
pixel saturation must be avoided. Alternatively, you may want to use the Fiji software
package to examine side projections of the data, to see if a re-position of the sample
is necessary. Further information regarding data checking in Fiji is given in Appendix
3: Checking Data in Fiji.

3.4.7 Step 7: Ending an imaging session

Once the imaging session has finished the sample can be safely removed from the
microscope by going to the stored “Sample Loading” position. When the stage has
reached the end of travel, the sample chamber should be carefully removed from the
mounting plate underneath the objectives, taking care not to spill any immersion media
over the stage top. Alternatively, a pipette can be used to reduce the level of liquid in
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the chamber to aid removal and a paper towel can be placed on the stage top to catch
any excess liquid drops. Finally, the objectives and the microscope enclosure should
be cleaned according to the “daily use” instructions in Section Error! Reference
source not found. Error! Reference source not found..

3.5 Advanced imaging controls
3.5.1 Other acquisition types

In addition to standard z-stacks, the Aurora system is capable of imaging in a multitude
of different acquisition types:

e Time-lapse, to image time-evolving processes and dynamic events in living
samples.

e Overview for easy sample navigation, to locate and move to positions of
interest over an area larger than the system field-of-view.

e Multi-position acquisitions, to create stacks at more than one position in the
sample, either as Multiple individual positions or as a Tiled grid
acquisition, generated stacks over a larger area than the system field-of-view.

3.5.1.1 Time-lapse

In the time-lapse settings tab (Figure 3-16), users can choose how many time-points
they wish to acquire, and the time between starting each stack.

Note: If the time between stacks is shorter than the time needed to acquire a stack,
there will be no delay between each stack acquisition: the time between starting each
time point will be the time needed to acquire a stack.

Channels [] z-stack
Time-Lapse [] Multi-Positions
Time points: |1
Time between starting stacks:| 1 ms.

Figure 3-16 Time-lapse settings

3.5.1.2 Overviews - introduction

For large, complex samples, navigating through the sample can be challenging given
the relatively high magnification of the system. The overview function is designed to
provide a quick overview of a large area of the sample, to help locate the sample or to
visualize a tiled grid prior to acquisition. Overview mode acquires planes in the same
way as Constant Velocity Acquisition, except it:
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e Requires a grid of tiles to be created beforehand.
e Generates a stitched preview of the sample automatically.

e Only acquires grid positions: will not work with Multi-Positions turned off, or if
only single positions have been added to the position list.

¢ Instead of generating multiple separate .tif files, overview files are saved as a
single .tif.

e Overview images cannot be deconvolved.
The overview stitched files can be quite large, so we recommend:
e Use binning of 4.
e Creating stacks with a very small number of slices / very large step-sizes.

The “Move stage to point” function can then be used on acquired overview images.

Note: For technical reasons, for the time being Overview images are ImageJ and not
Micro-Manager images: this means that the contrast has to be adjusted using ImageJ
contrast window (Ctrl+Shift+C) rather than using the Micro-Manager histogram window.

3.5.1.3 Overview generation and move-stage-to-point navigation

To image a rough overview of the current area, we suggest the following workflow:

e Ensure the correct immersion medium has been selected.

M Start Acquisition
SQUARED

Overview

Immersion Medium

PBS v + = Edit

Figure 3-17 The immersion medium drop-down menu

e Set camera binning to the highest level available (4 on most cameras).

Exp. (ms) Binning
Live 10,007 1

Snap single image Crop Image

Single-RFP ~
561 Laser I 1 %

Figure 3-18 The binning drop-down menu
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e Open the “Position List”

PoS iv | + - =N
Channels [ z-Stack
[ Time-Lapse [ MultiPositions
XY.X
Open Position List
Clear Position List ‘
Z Stage: 0
XZ Stage:
XY.X Stage
XY.Y Stag

Figure 3-19 Opening the position list window

e On the position list, use the function to create a grid of tiles centred on the

current stage position.

204.6

4046 | Create tiles centered here

-404.6

204.6 Create grid centered on the current stage
204.6 position with the below dimensions.
_404.6 Units are millimetres

-404.6 Width|1 Height 1 Depth 1

Grid Orientation: Camera plane

Apply changes

Figure 3-20 Controls for generating a grid of tiles within the Position List window

e If a stack is desired with the overview (and we recommend it), select a grid
position on the position list and change the stack settings to record a low
number of steps (e.g. 10) and press “Apply changes”. You can also edit the
stack start and end and which channels you’'d like to acquire.

Frilt przltinn stack Fdlt pesltion channgl seHIngs
Eppky changrs apphy changes
Reclalive posilicr: Cha i)
Sl s Slack lur Lhis posiLion: Channel B L1 Pl Chianngls or Wiz pusilion:
Wsbble delav: 0see [ |wightfield |10 |- - |1 Lape 100, 88, 5.0
Fovus Slage: K2 - Helnfive pnstions . [GFP 100 |488 5.0
StdglEi 31%3 WEP single | 000 [l 0
jubible duley (sees Slarl: - — y
Wobble deley (sews 30 St 0TD T 0.0 361 20
stack start <100 st [ Zigp T el
Slack Size: 200 um
P— KL sliees: i
Slack end 100
Tietine slve ot steps 0.4 Jim <
< ¥

Figure 3-21 Choosing the desired stack and channel settings within the Position List window
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e Ensure the Z-Stack checkbox is ticked on the Acquisition Settings panel (if a
stack is desired; if not, untick it) and the Time-Lapse checkbox is unticked.

Channels Z-Stack

[[] Tme-apse Multi-Positions

Figure 3-22 Double-check that Z-stack is ticked

Below the big red button, choose overview mode and then start acquisition.

M Start Acquisition

SQUARED

Overview v

Figure 3-23 Selecting the overview acquisition mode

e After the overview image has been created, you can scroll through the stack
(if one was acquired) and look for an area of interest in the image. Ensure that
the overview is selected in the “Current Overview Acquisitions” dropdown box.
Once an area of interest has been found, you can click the “Move stage to
point” button:

XY.Y Current Overview Acquisitions:

% No Images Open

Move stage to point

z
A

A A
7\

N\
I > D> D

Figure 3-24 The move-to-point controls for navigating using an overview image

e And click on the area of interest in the image. A small window will pop-up
allowing you to confirm you'd like to move the stages to the calculated
coordinates. Once you press OK, the stages will move to that point of interest,
and the field of view should be centred on the clicked area.

e It should be noted that, for stack sizes with a large step size, the area of
interest might be a few tens or hundreds of microns above or below the new
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stage position, due to the large step size. A small focus adjustment in Z will
rectify this.

e If nothing of interest appears, try to repeat the process but for a larger area
and stack size.

IMPORTANT: ONCE THE AREA OF INTEREST HAS BEEN FOUND, REMEMBER TO RESET THE
BINNING TO “7” BEFORE ACQUIRING ANY IMAGES. IMAGES RECORDED WITH BINNING > 1
WILL NOT BE FULL RESOLUTION AND ARE NOT RECOMMENDED FOR DATA THAT IS
INTENDED FOR DECONVOLUTION.

3.5.2 Multi-positions

Multi-position acquisitions allow the user to acquire several different sample positions
automatically. To achieve this, users make use of the “Position List” window which
opens when the "Open Position List" button is pressed (Figure 3-25).

+ = Edit
Channels [] z-stack
[[] Time-Lapse [[] Multi-Positions
XY.X
Open Position List
Clear Position List “:
Z Stage: 0
XZ Stage:
XY.X Stage
XY.Y Stagi

Figure 3-25 The "Open Position List" button is available
under the "Multi-Positions" tab

The list can be populated in 3 ways:

e Multiple positions where several individual positions are imaged as separate
stacks:

o Performed by navigating to the desired locations and pressing the
anchor button in the main GUI window (Figure 3-24) or the “Add” button
on the top left of the Position List (Figure 3-27).

e Tiled grid where a large area of overlapping tiles is acquired. These tiles can
be generated in two ways:

o By creating a grid of tiles centred in the current stage position.
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o By creating a grid of tiles based on several positions that the user first
adds to the position list.
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| &84 Position List

Add Narme Type Xz XYX XYY z Tiie firoiarias
Move Stages To o2 1 0601 AR0L |Grid: Cameraplane: [SO0.0- 2o jea:2 j20EE :
U lmZ_1_0001_0002  |Geid: Camera plane |500.0 7954 |930.8 2046 Grid Name | m2
Update m2_1 00020002 |Grid: Camera plane |500.0 9045 930.8 |404.6
m2_1_0002_0001 |Grid: Camera plane  |500.0 9046 l60.2 4046 Owerlap (%) 1

Remuove Position 4
Position_5

Single 5000.0 GO0.0 1499085 -100.0 Create tiles from positions

Position Up
Position Down

Clear

Save List
Load List
Camera properties:
Current binning: 1
Set Binning 1 ~
Apply to pos.
Currenl ROT:
X:0,¥:0

Width: 2048
Height: 2048

Create tlles and stack from selected positions.
I Kaap positions?
Grid Orientation: Camura plane

Create tiles

Create tiles centerad hare
Create orid centered on the current stage

position with the below dimensions.
Units are millimetres

Width{ Height 1  Depth{1
Grid Orientation: Camera plapg

Create tiles

Edit position stack

Relative pasitions

Focus Stage: | ¥2Z

Wobble delay (secs )0

Stack start | 100 St
Go to middle
Stackend 100 Caf
Define size of steps 0.4

1 Edit position channel settings-

Apply changes . Apply changes
Stack for this position: | Channel Exp L1 Pw(%).1 Channels for this position:
Waobble delay: 0 sec. | [ |Brightfield  [t0.0 |- |- ~ | GFP, Exp! 10.0,488, 5.0
- Relatlve positions 'E GFP 10.0 [488 (5.0 |

;“g‘fi ;‘go 1| [RFP-Single [t0.0 (361 |20

i PP ol e Pt B L

T 0.0 |24
End: 100 .-|_ tal 1 361 2.0
G Step Size: 04.um
Gtack Size: 200 um
N. Slicas: 500
| W
L4 >

Figure 3-27 The Position List window

Add

1

m

Move Stages To =
m

Update |

m

Remove E

P

Position Up N

Position Down

Clear

Save List
Load List
Camera properties
Current binning: 1
Set Binning |1
Apply to pos.
Current ROI:
X:0,Y:0

Width: 2048
Height: 2048

Figure 3-26 Basic Position
List functionality

These last two options are described in the sections 3.5.2.4 to
3.5.2.6. Once positions have been added to the list in any way,
they will be acquired in the order they appear in the position list
window.

Each position can be manually renamed and have their
coordinates edited by double-clicking on the relevant area, unless
they are part of a grid.

3.5.2.1 Basic Position List functions

The left hand-side of the Position List (Figure 3-26) contains
several basic functions to manage the positions on the list.

o Add: Adds the current stage position to the list.

o Move Stages To: if a position has been selected on the
list, will move the stages to that position.
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Update: if a position has been selected on the list, will update the coordinates
with the current stage position.

Remove: if one or more positions have been selected on the list, they will be
removed. If any one of the positions is part of a grid, a confirmation window
will ask the user whether he wants to remove just the selected positions, or
the entire grid associated with that position.

Position Up: if one or more positions have been selected on the list, will move
those positions up on the order of acquisition.

Position Down: if one or more positions have been selected on the list, will
move those positions up on the order of acquisition.

Clear: will remove all positions on the list.
Save List: will save current position list to a .json file.

Load List: will load a previous position list from a .json file.

3.5.2.2 Camera properties

Each position/grid has it's own settings for camera binning level and crop level. The
camera properties section shows the bin and crop associated with the currently
selected position/grid. The camera cropping information can not be changed but the
binning can be changed by selecting from the down-down menu (see Figure 3-26) and

clicking “Apply to pos.”.

3.5.2.3 Position/grid stack and channel settings

Fulil pesil i slack Filil pesilion « lannel sellings
Apply changes Apply «haneges
Heleliv siliuns = - T
20 oo Slack Tur Lhis posilicn: Channel Bep L1 MwilSe)l Chanmals for this pusilion:
wcbble dalay: U cac. _||criaghtfigid 100 |- - -~ Gl R, Lxpe 100, 484, 5.0
Focus Stage: HE = ﬁelztl'.'e positions | |Gre 100|488 |50
SIS "]|RFP - Single [10.0 [561 |20
Wabable delay (secs )0 'E;Z’F-l;:w [ 100 [se1 |20
- 0 g Step Slze: 04 um
Stackstart | -100 Set
e - Stack Slze: 200 um
e Lo micille M. Slices: 500
ok w10 Lal
Define size of staps U4 pm e
< >

Figure 3-28 Position Stack and Channel Settings

Each position and grid have their own stack and channel settings associated with it.
Select one position on the list to see the current settings for that position or its

associated grid.

To modify the settings, edit the values on either panel according to sections 3.4.2.3

and 3.4.2.1, and then press “Apply changes”.
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IMPORTANT: PLEASE NOTE, THAT GRID POSITIONS CANNOT BE SET TO “ABSOLUTE

POSITIONS” STACK MODE.

3.5.2.4 Common tile grid settings

First, all grids of tiles share certain properties regardless of how the grid is created:

Tile properties

Grid Name ' m2
Overlap (%) 10

Create tiles from positions

Create tiles and stack from selected

Figure 3-29 Common tile properties

e A unique name (if the same name is used more than once, a number is

appended to it)

e An overlap between each tile (in percentage)

3.5.2.5 Creating a centred grid

To create a grid of positions that cover an area centered on the current stage position,
use the panel titled “Create tiles centered here” on the middle of the right-hand side of
the Position List window (Figure 3-30). Specify the height, width and stack size (in
mm) of the area and press “Create tiles”. The position list window will be populated with
the smallest number of tiles that cover the area with the properties set as in section

3.5.2.4.

204.6
-404.6
-404.6
204.6
204.6
-404.6
-404.6

Create tiles centered here

Create grid centered on the current stage
position with the below dimensions.
Units are millimetres

Width| 1 Height/1 Depth 1

Grid Orientation: Camera plane

i Create tiles :

Apply changes

Figure 3-30 Panel to create centered grids of tiles

WARNING: ENSURE THE CORRECT IMMERSION MEDIUM AND BINNING SETTINGS HAVE
BEEN SELECTED BEFORE CREATING THE GRID, AS THESE SETTINGS ARE DIRECTLY
RELATED TO HOW THE GRID COORDINATES ARE GENERATED AND CAN’T BE CHANGED

AFTERWARDS.
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Note: The field-of-view (FOV) of the camera will limit how small the area covered is.

Figure 3-31 Diagram of the effect field of
view has on the area covered

For example, on a system with an 800 um x 800 um FOV (Figure 3-31, blue box) a
user may ask the GUI to cover a 1.00 mm x 1.00 mm area (Figure 3-31 green box)
with no overlap between the tiles. In this instance, the smallest grid that can cover a
1.00 mm x 1.00 mm area with the system’s 800 um x 800 um FOV with no overlap will
be 1.60 mm x 1.60 mm wide (Figure 3-31, grid in red).

3.5.2.6 Creating a grid from a list of positions

Overlap (%) 1

Create tiles from positions
Create tiles and stack from selected positions.

™ Keep positions?

Grid Orientation: Camera plane

Create tiles

Create tiles centered here

Craata arid cantarad an tha cireant cbann

Figure 3-32 Create tiles from positions panel

Users can also create a grid of tiles that cover a number of positions that have already
been added to the position list using the “Create tiles from positions” panel (Figure 3-32).
The software will take all of the positions and create a grid that includes all of the
positions. It will also create an associated stack that covers the points added in the
focus direction as well. To start, select the relevant positions on the main position list
and then press “Create tiles”. A grid of tiles is created that covers all of the added
positions with the properties set as in section 3.5.2.4. You may then adjust the stack
settings (step size/number of steps) in the main window as described in 3.5.2.2.

Note for beam scanning only systems: Due to the limited range of the beam
scanning systems, the GUI will tile not only in X and Y, but also in Z.
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3.5.3 Additional Acquisition modes

Start Acguisition

Constant Velocity Acg. -~

Constant Velocity Acg.
Overview

Va2 tart/stop Acq. it
|Static Beam

Figure 3-33 The Acquisition mode drop-
down menu

Below the “Start Acquisition” button is a dropdown menu allowing selection of
additional acquisition modes (Figure 3-33).

3.5.3.1 Start/Stop Acquisition

The traditional method of acquiring an image stack, as an alternative mode to the
Constant Velocity Acquisition. The light sheet or the sample is moved to each sequential
position in the stack, stopping movement for each acquisition. The method is
significantly slower than Constant Velocity Acquisition and is mostly used for
troubleshooting.

3.5.3.2 Static Beam

An important mode which is used to acquire the beam shape data for calibration and
geometric correction during deconvolution. Static Beam mode by-passes the Z-Stack
options and turns off the resonant scanner, stopping the light sheet from being formed
along the Y-axis. The curved propagation of the Airy beam is visible in images taken
in this mode, and only a single image is taken for each channel.

To image the beam, simply ensure that the objective lenses are immersed in the
immersion medium and navigate to the side of any specimen that is mounted on the
stage, ensuring that the specimen is not located in the field of view, before starting
acquisition. Alternatively, a very dilute mix of water and a fluorescent dye can be used.
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Appendices
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4 APPENDIX 1: FILE FORMAT

4.1 Context

The folder naming scheme was developed during the very earliest stages of the
microscope’s development to make the deconvolution compatible with micro-manager
files in as simple a way as possible. While the program has developed significantly,
the naming scheme has been kept so far as a way to maintain compatibility with legacy
code.

4.2 Channel names

With the current scheme, each acquisition is placed on a folder that contains the
channel that it was acquired with. This folder name is used by the deconvolution
software to find the correct calibration file for the given channel.

4.3 Timestamp

Each complex acquisition can be identified by a unique timestamp. This timestamp
corresponds to the beginning of the acquisition and it will not change during whole
acquisition, even for time lapses or multi-position acquisitions.

4.4 Stacks over 4 GB
For stacks larger than 4 GB, micro-manager splits the stack into many tiffs, each with
4 GB. These are all placed on the same folder.

4.5 Folder naming scheme

45.1 Base folder name

Every stack is saved on its own folder. The folder name will hold all relevant
information for that stack and follows a consistent pattern. Below is the base structure
that each folder name follows:

_Step_Size_ _Wavelength_

e Mandatory parts of the name that are always present are in bold.
e Mandatory values that change for each acquisition are in

In addition, between the channel name and the user provided name, the name can
include the below text:

¢ Parts that may sometimes be present but otherwise won’t change are
in

e Optional values that change for each acquisition are in

37



Version 1.2 — Acquisition Manual: Aurora Airy Beam Light Sheet Imaging System

Acquisition version: 0.5.0

4.5.2 Example folder names generated with the plugin

Single stack:

J _Step_Size_+0.5_Wavelength_

Time lapse:

o _Step_Size _Wavelength_Cy5_Frame_2_

Multi-position time lapse:

o _Step_Size _Wavelength_Cy5 Frame_1_Po
sition_Pos0 _
4.5.3 Complex Acquisitions

When a stack is acquired with multiple colors, as a time-lapse, as multiple positions,
or a combination of these, the folders are grouped together in one acquisition folder
(unless the “Split in folders” option is toggled off, in which case all folders will be
saved on the same root folder). Below are listed the different ways the folders can be
grouped. Where you see folder name, this corresponds to the dynamically generated
folder name described above.

Multicolor:

timeStamp_userProvidedName / folder _name / MMStack.ome.tif

Time lapse:

timeStamp_ userProvidedName timelape / folder _name / MMStack.ome.tif
Multi-position:

timeStamp_ userProvidedName / positionName / folder _name / MMStack.ome.tif
Multi-position time lapse:

timeStamp_userProvidedName_timelape / positionName / folder_name [
MMStack.ome.tif

38



Version 1.2 — Acquisition Manual: Aurora Airy Beam Light Sheet Imaging System

Acquisition version: 0.5.0

Figure 4-1 shows an example of a multi-color, multi-position, time lapse acquisition and
how it is shown on the hard-drive.

\File Tests\Structure\180226_16.51.39_userProvidedString.MultiPositionTimelapseMultiColour_timelapse\Pos0

~
Name

180226_16.51.39_Step_Size_+0.3_Wavelength_Cy5_Frame_1_Position_Pos0_userProvidedString.MultiPositionTimeLapseMultiColour
180226_16.51.39_Step_Size_+0.3_Wavelength_Cy5_Frame_2_Position_Pos0_userProvidedString.MultiPositionTimeLapseMultiColour
180226_16.51.39_Step_Size_+0.3_Wavelength_DAPI_Frame_1_Position_Pos0_userProvidedString.MultiPositionTimelapseMultiColour
180226_16.51.39_Step_Size_+0.3_Wavelength_DAPI_Frame_2_Position_Pos0_userProvidedString.MultiPositionTimelapseMultiColour
180226_16.51.39_Step_Size_+0.3_Wavelength_FITC_Frame_1_Position_Pos0_userProvidedString.MultiPositionTimeLapseMultiColour
180226_16.51.39_Step_Size_+0.3_Wavelength_FITC_Frame_2_Position_Pos0_userProvidedString.MultiPositionTimelapseMultiColour
180226_16.51.39_Step_Size_+0.3_Wavelength_Rhodamine_Frame_1_Position_Pos0_userProvidedString.MultiPositionTimelLapseMultiColour
180226_16.51.39_Step_Size_+0.3_Wavelength_Rhodamine_Frame_2_Position_Pos0_userProvidedString.MultiPositionTimeLapseMultiColour

Figure 4-1 Example of a multi-color, multi-position, time lapse folder

4.6 Folder names must not be changed

For the time being, the information that the deconvolution requires is saved on the
folder names created during acquisition. As such, the folder name of the data being
stored should not be altered, as it may break what the deconvolution software expects
from the acquisition.

This will change in future software releases, when both deconvolution and acquisition
transition to a new file format.
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5 APPENDIX 2: SOFTWARE NOTES

5.1 General points
Both Acquisition and Calibration/Deconvolution software packages are in constant
development, and each version may have some interface changes, as well as
presenting bugs and other hitherto unknown issues that will be resolved in
forthcoming versions. Versions are numbered according to a three-digit system
which is detailed below.

5.1.1 Numbering scheme

e MAJOR number (v0.1.2): A new public release that is not backwards
compatible. For the Aurora™ development program, this will remain at 0 until
the public release of a production system.

e MINOR number (v0.1.2): Addition of any new major features to the software
that have gone through regression testing. For example, the overview
functions, or the beam scanning capability.

e BUGFIX number (v0.1.2): Small bug fixes, usually addressing specific issues
a client has faced. Small interface changes may occur to address some
issues and some minor features may be implemented.

5.1.2 Addressing bugs
Any issues that are found can be reported on the website:

https://www.msqguaredcubes.com.

To access the website, you need the username and password which was assigned to
you upon training. Otherwise, please speak with the person in charge of your system.
If you do not get a response quickly enough, please email:

pedro.almada@m?2lasers.com

5.1.3 Checking your software version

The user guide is matched to a specific version. Please make sure that the version of
the software that is installed on your system matches this guide’s version number. You
can do so by checking what the title is for the software windows.

[£M Squared Aurora Acquisition plugi

i Exp. (ms) Binning
Live 100 4 . k

Figure 5-1 Title of the acquisition window showing the version number.
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5.2 Specific notes relating to the Acquisition Software
5.2.1 Micro-Manager

To accelerate the development stages of the system, the 0.x.x version Acquisition
software builds are deployed as a Micro-Manager plugin, and therefore some of the
code is not controlled by M Squared. Certain issues originating from the use of Micro-
Manager rather than the M Squared plugin may require longer to fix than M Squared
related issues.

5.2.2 Each system is different

Each Aurora™ system is different, with different capabilities and optics. The
acquisition software will appear slightly different depending on your system set up.
This manual has been developed in a general format to cover as many systems as
possible, but if you need help with something that isn’t mentioned here then, please
contact the M Squared Life team so we can rectify this.

5.2.3 Installation/Updating

Installing and initial configuration of the software will be performed by M Squared Life.
If you require reinstallation of the software, contact the M Squared Life team to perform
an installation for you.

Once the software has been installed, any user should be able to update the software
via the M Squared Cubes website https://www.msquaredcubes.com. The site requires
your own account to access. Please contact the M Squared Life team for login details.

The acquisition software is installed as two components: a base package, which
contains the main elements of the software which will not require modification between
software versions, and a bundle of library files associated with a particular software
version. The base package structure will be stored in:

C:\Applications\Aurora-Acquisition\

To update the software to a new version, please follow the instructions given in the
release notes on the website.

5.2.4 Backing up the configuration

Starting with version 0.4 of the acquisition software, all the settings are saved in a
JSON file in the Micro-Manager root. To fully back up the configuration, you should
copy the Micro-Manager configuration file (ending in . cfg) that is requested on Micro-
Manager’s startup as well as the “AuroraGUIConfiguration.json” file on Micro-
Manager’s root.

In addition, the GUI also saved the preset stage positions (see 3.2.3.3) on separate
JSON file called “AuroraGUIPresetPositions. json” that may be backed up as
well.

41


https://www.msquaredcubes.com/

Version 1.2 — Acquisition Manual: Aurora Airy Beam Light Sheet Imaging System

Acquisition version: 0.5.0

5.3 Specific notes relating to the Deconvolution Software
5.3.1 Installation/Updating

If installing for the first time, you'll need to download two zip files (explained below)
from www.msquaredcubes.com/downloads.

You will need to download two files:

e The “Base Deconvolution Installation” package
¢ And a specific deconvolution package (e.g. “Deconvolution 0.4.0”).

Once the files have been downloaded, extract the base installation package to its
destination folder (we have used “C:\Applications” in the past and use "C:\M
Squared\Deconvolution™ more recently). Once that has been done, you can
extract the specific update Package to the same folder as the Base Deconvolution
Package and replace any files that may be there.

5.3.2 Updating drivers

The deconvolution software can make use of NVIDIA GPUs to accelerate the
deconvolution. In order to do that, please make sure you have the latest NVIDIA
drivers installed.

5.3.3 Create a desktop shortcut

To create a desktop shortcut, navigate to the M Squared Cubes software folder and
locate the "Aurora.exe" file, then “Right click > Create shortcut”. Feel free to rename the
shortcut as desired.

5.4 Updating the software

If you already have the Base Deconvolution package extracted in a folder, in most
cases you should only need a specific deconvolution package (e.g. “Deconvolution
0.4.1").

Occasionally a specific deconvolution package will request you to upgrade the base
deconvolution package to a specific version. In those cases, you will need to download
the base deconvolution package as well.

Extract the downloaded .zip(s) to the root directory where you have installed Aurora
Deconvolution software previously.

The shortcut you have created previously should work without needing any changes.
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6 APPENDIX 3: CHECKING DATA IN FIJI

6.1 Raw data verification in Fiji/lmageJ

Fiji is a free open-source scientific image processing software used widely in the life
sciences. This section suggests workflows within Fiji which will allow the user to
assess the viability of their acquired data. For example, the data may lack the desired
structures of interest or may exhibit unwanted artefacts resulting from undetected
issues during acquisition, such as a discontinuous shift in the data stack which can
occur if the optical table was accidently knocked.

Double-click the Fiji desktop icon to open Fiji.

U (Fiji Is Just) Image)
File Edit Image Process Analyze Plugins Window Help

Olo|z|ofE £ |« |\ [Ala|o|O]| cfsw|w]s|sa] |»

Text tool (double-click to configure)

Figure 6-1 Fiji Figure 6-2 Fiji toolbar window.
desktop icon.

6.1.1 Open the dataset

Open the acquired volumetric dataset by dragging and dropping the .tif data or its
parent folder onto the Fiji toolbar. Alternatively, data can be opened by selecting “File
> Open” and finding the file through Fiji’s file browser window.

6.1.2 Check acquired volume

Make sure that all image planes of the data stack contain the relevant structural
information and that at no point are there any discontinuous shifts in the data. For
example, sometimes a translation of the specimen may be observable. This may occur
when a sample has not been held in position appropriately and becomes patrtially
detached during acquisition.

Another common issue can occur when a sample embedded in agarose has a bubble
adjacent to it in the path of the light sheet or the detection optics. Such air bubbles can
easily cause lensing which adversely affects the performance of the deconvolution
algorithm and results in sub-optimal output images.

6.1.3 Examine the volumetric dataset in other views

6.1.3.1 Check and set the image step size

Upon loading, Fiji will automatically assume that the step size between planes is equal
to the lateral pixel size, which is typically not the case. Before examining the data set
in other views, it is beneficial to ensure that the step size is set correctly.
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To set the step size select “Image > Properties... “ to bring up the image properties
window. Here you can adjust the step size to match the acquisition by setting the
correct value for “Voxel depth” and pressing OK.

6.1.3.2 Using Ortho-viewer (quick & interactive)

A quick way to examine the dataset from the side is to use Fiji’s built-in Ortho-viewer.
This can be easily achieved by using the hot keys Ctrl+Shift+H or by selecting “Image >
Stacks > Orthogonal Views” in the menu bar. Windows displaying the resliced on the XZ
and YX axes are automatically generated and placed along either edge of the normal
XY orientation. Clicking on a position in the XY view stack re-locates the vertical and
horizontal yellow lines which indicate the planes being displayed in the neighbouring
XZ and YZ display windows. Using either the mouse wheel or arrow keys in the XY
view moves the yellow line indicating the Z-plane in the side-view windows.

It is worth noting that only a limited amount of structure may be visible in the side-view
windows as they are only displaying data which is one voxel deep. To make more of
the structure visible from these perspectives it is advisable to generate maximum
intensity projections, as detailed in the following section.

[° (Fiji Is Just) Image)
File Ed\tPrucess Analyze Plugins Window Help
clolE e O] oesufwr] o4& ] |

Freehand sel
Adjust

Show Info___ Ctri+l

Properties. .. Ctrl+Shift+P

Calor

Hyperstacks ¥ Delete Slice
Next Slice [>]
Previous Slice [<]
Set Slice. .

Crop Ctrl+Shift+X

Duplicate. . Ctrl+Shift+D

Rename...

Scale.. Ctrl+E | Images to Stack

Transform ¥ Stackto Images

Zoom ¥ Make Montage...

Overlay ¥ Reslice [f]...

Lookup Tables 4
Z Project...

' 3D Project...

' Plot Z-axis Profile

" Lael..

Axes | Statistics

Convert Animation

Annotate
Drawing
Video Editing

Convolve Tools
Threshold

"\ Radial Reslice

Dynamic Reslice
Series Labeler
Kalman Stack Filter
Time Stamper
Reslice Z

View5D

Figure 6-3 Displaying orthographic views in Fiji.

6.1.3.3 Generate maximum-intensity projections

Maximum intensity projections allow the structure throughout the stack to be more
easily visualized. M Squared Life provide scripts which allow easy generation of
maximum projection images along all three axes through the data stack, or if preferred
these projections can be generated manually. A range of M Squared Life scripts for
Fiji can be downloaded from the User portal at
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https://www.msquaredcubes.com/scripts. To quickly bring up the script editor in Fiji
press the open square bracket key “[“. Navigate to the MakeProjections.ijm
script using “File > Open” in the script editor and press the “Run” button to bring up the
projection generation options window. Here you can select the axes you want to
generate projections along, as well as the fraction of the field of view you desire the
side projections to be run along. For example, if the fraction of the field of view is
entered as “0.1”, then only 10% of the field of view will be used for the corresponding
XZ or YZ projection, i.e. the projection will be from a resliced depth of 2048 x 0.1= 204
voxels deep. Projections will be generated in new windows to be saved wherever is
appropriate.

L2l
File Edit Language Templates Run Tools Git Tabs Options

‘ [+] l [ l t : 'MakeProjections.ijm (Running) |

Llean (la

ID

deccrintinn = "tect™) it

ate measuremeq=

1 | £ script:D:\Code\AuroraScripts\Image/\MakeProjections.ijm X

set th el size ahead

DoXz? W projections d

DoYZ? |
DoXY? L
Interpolate?
Interpolation is required for accurate measurements,
but you also need to set the voxel size ahead of time.
Otherwise, it siows projections down.

Close original? [v]

Fraction of the FOV to analyse 0 1j > =
LEZE
Cancel Show Errors l Clear [ »
Started MakeProjections.ijm at Wed May 06 14:31:05 BST 2020

Figure 6-4 M Squared maximum intensity projection Fiji script.

Alternatively, projections can be generated manually for each axis of the data cube.
The easiest view to project is XY view since the data doesn’t have to be redisplayed,
or “resliced”, along a different axis. Once the data set is open, go to “Image > Stacks >
Z Project...” in the menu bar. A Z-Projection options window then opens where you can
choose the depth range of slices in the stack to project over, by default the whole stack
is selected. Maximum intensity is generally the most useful projection type.
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Figure 6-5 Generating a stack projection in Fiji.

To generate projections along other axes the same process can be applied to stacks
which have been resliced along the desired axes. To reslice an open dataset, go to
“Image > Stacks > Reslice [/]...” or press the forward slash “/” character on the keyboard,
both of which will bring up the Reslice options window.

In the reslice options window the reslice axis is selected using the “Start at:” dropdown
menu. If started from the top or bottom the Y axis becomes the new depth axis and a
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Figure 6-6 Reslicing a stack in Fiji.
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XZ stack will be generated. If started from the left or right the X axis becomes the new
depth axis and a YZ stack will be generated.

Note that interpolation should be considered carefully before generating projections
using this option. With interpolation off, all data presented in the side-projection directly
corresponds to the pixel values recorded at each voxel (pixel and z-slice coordinate).
However, the pixel size along z in the side projection will appear the same as the pixel
size along x or y. Unless the data has been taken with the same z-step size as the
lateral pixel size the side-projection will make the sample look compressed or
stretched along z. With interpolation on the data is displayed in the side projection with
a matching pixel size along z and x or y. But Fiji performs this by estimating signals
between the z-planes, meaning that the presented signals are an interpretation of the
data, rather than matching exactly.
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7 IMAGING GUIDELINE: EXAMPLE WALKTHROUGH

7.1 An example: adjusting image contrast and signal levels
The following section gives an example of how to adjust image contrast in the Micro-

EMicvo-Ma ager 1422 ager-1.4\Aurora Alpha ... Tk =k
‘Fiie Tools Plugins Help
c

........

42 95525

Figure 7-1 Manually lowering the upper histogram limit
handle.

Manager histogram window to check the camera signal level during data acquisition.
Fundamentally, the exposure and laser power will determine the signal level that you
acquire from your fluorescent specimen, the contrast adjustment allows you to alter
the display to get a feel for the quality of the signal you are receiving.
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Figure 7-2 Beam image with a high upper histogram
limit appears blank.

As stated earlier, it is best to ensure that the maximum pixel intensity is between
15,000 to 32,000, so that the signal-to-background ratio is as high as possible, but you
don’t lose data from saturation near 65,535. For example, when imaging the beam
using fluorescently dyed water, Micro-Manager starts up with a default setting which
leads to a completely black snap/live screen:

If the upper signal handle is dragged down to a lower value without changing any laser
or exposure settings, you will allow dim objects to become visible in the displayed
image. In this example the exposure and laser power are set to 1,000ms and 13%,

Figure 7-3 Beam image resulting from lowering the
upper histogram limit becomes visible.
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producing maximum and minimum signals of 1,288 and 37 respectively. An upper
signal display value of 5,642 makes the beam barely visible in the Live view window.

Reducing the upper signal handle to a lower value means that the maximum pixel
intensity that is displayed in the live window corresponds to a lower actual signal level.
This means that the maximum available signal-to-background ratio will also decrease.
A better signal-to-background level can be acquired for this imaging example of an
Airy beam by increasing the slider to a higher value whilst simultaneously increasing
exposure and laser power.

'Mim)—M ager 14.22 - C:\Program
4 ro-Manager 1.4.22
File Tools Plugins Help

Autostratch Log hist

Az 05635

Figure 7-5 Increasing the upper histogram limit for a Figure 7-4 Higher power and longer exposure beam
longer exposure image of a higher power beam. image with new upper histogram limit makes the beam
clearly visible with a good signal-to-background level.

After changing the exposure and laser power to 2,000ms and 100% respectively, the
maximum and minimum signals are 12,885 and 28 respectively. With the upper
contrast signal handle set to a maximum of 16,817, the image has better signal-to-
background ratio than the previous image, which had a maximum of only 5,642.
Clearly, the beam can be seen to be clearer, sharper and more easily recognized as
an Airy beam. In this example the dye concentration was very low, so an extremely
high laser power and long exposure was required. Well-stained fluorescent specimens
should never require such excessive photon dosages to result in good signal images.
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